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WinSales 3.x and 4.x User Settings

WinSales Versions: 3.x, 4.x

Revised: 11/15/99
Some aspects of WinSales' behavior can be controlled by the end user.  These user settings provide control of the way WinSales displays and prints data, the paths in which WinSales searches for data, programs and documents, performance tuning controls and more.  To view and maintain settings, refer to User Settings in Chapter 3.

Defining WinSales Options
You may set WinSales options and attributes for the user you are logged in as by choosing Settings from the Options menu in WinSales.  Or in the WinSales Administrator you can select User Settings from the Edit menu and modify any users settings.

[image: image2.png]ship Management

powered by WINSALES inerscrive






Tab Contents
These groups of settings are used:

General
The font used to print quick reports, the active campaign, the OLE path, and whether or not mail is enabled.

Word Processing
The paths and templates of the word processing applications you are using with WinSales.

Contact
The validation routines that are performed when new contact records are added.

Sync
Remote synchronization information such as the number of extracts and imports performed.

Tuning
Search results attributes and the elements to display in the activity log.

Calendar
Calendar attributes.

Dialer
Settings for controlling modems and dialer functionality.

Editor
Displayed only through the WinSales Administrator (see below).

Changing a Setting
You can change settings for a user by logging into WinSales and selecting Settings from the Options menu.

Or through WinSales Administrator you can gain access to all users settings.  Log into the WinSales Administrator and select User Settings from the View menu.  Select the User you wish to change settings for.

Click on the tab that contains the setting you want to adjust.  Click on the parameter in the Options list.  Enter the new setting in the New Setting box.  Click SAVE.  These settings are actually stored in the WinSales database.

The Editor Tab
This Tab allows a Text Editor view of the settings where settings that are not used can be deleted (be careful!!) and settings that potentially are missing could be added.  Another useful function is copy all of a users’ settings to another user.  To do this choose the User you want to copy from and choose 

the Editor tab.  Right click and Select All in the Editor, then Copy.  Select the different User and choose the Editor tab to display that users settings.  Right click and Select all, then Paste the other user’s settings in and SAVE.

To Print Settings
You can print a users settings by selecting the Print button on the settings window in WinSales or WinSales Administrator.

In the Startup category:

Username



The name of the user.  Used for login default.

SalesRep



The name of the sales rep.  Used for new activity default.

LastDBOpen



Index into list of databases, used for login default.

General Tab

Campaign


Campaign assigned to the first activity logged or scheduled for a new contact.

AdjustDateTime    
When activity is resolved or canceled, does the date and time on that activity get changed to the current system date and time?  0=no, 1=yes.

QuickPrintFontName

Font used by File+Print menu item.

QuickPrintFontSize

Font size used by File+Print menu item.

QuickPrintFontBold

Bold setting used by File+Print menu item.  0=no, 1=yes.

QuickPrintFontItalic

Italics setting used by File+Print menu item.  0=no, 1=yes.

QuickPrintFontUnderline
Underline setting used by File+Print.  0=no, 1=yes.                                     

QuickPrintFontColor

Color used by File+Print menu item.

UseEMail


Shall WinSales provide an interface to your MAPI-compliant e-mail system?  0=no, 1=yes.

OLELocalPath
Path 

WinSales assumes for OLE files, when using a remote database, unless path is included in filename.

OLEPath
Path WinSales assumes for OLE files, when using a stand-alone or master database, unless path is included in filename.

DashBoardPath
Path in which Management Dashboard files are placed by WinSales, and path to which Management Dashboard looks for queries and graphs.

Word Processing Tab

FormLetterPath

Path WinSales assumes for form letters, unless path is included in filename.

FormLetterDateMask
Format for printing dates in letters.  For mask options, see the Chapter 4, To create a simple field, Mask, Date/Time mask table.

FormLetterHeader
Path and name of WINSALES.HDR file.  See the WinSales Guide to Relationship Marketing, Chapter 3 for more information on this file.

MSWordTemplate

Path and name of WinSales template for Microsoft Word for Windows.

WordVersion


Version of Microsoft Word for Windows you are using (2.0 or 6.0).

WPVersion


Version of WordPerfect for Windows you are used (5.2, 6.0 or 6.1).

WordPerfectTemplate
Path and name of document that serves as WordPerfect for Windows' template for new letters created for use with WinSales.

MSWordPath


Path in which Microsoft Word for Windows program resides.

AmiProPath


Path in which Lotus Ami Pro program resides.

FormLetterLocalPath
Path WinSales assumes for form letters, when using a remote database, unless path is included in filename.

AmiProTemplate

Path and name of WinSales template for Lotus Ami Pro.

WPPreference


File name extension for word processor used most often (., .doc, .wpd, .frm, .sam).

LastLabelFile
Path and name of file containing mailing label or envelope format last used by WinSales Fulfillment Center.

EmailMethodField
The name of a field in activity tables that will contain the method of sending a form letter (e.g., the Method field in the Correspondence table).  WinSales sends e-mail instead of invoking your word processor if this field contains the value specified by the EMailMethodValue setting.

EmailMethodValue
The value to check the EMailMethodField against for determining if an e-mail transmission should occur as opposed to a word processing mail/merge (e.g. "E-Mail", as in the Method field in the Correspondence table).

EmailSubjectField
The name of a field in activity tables that will contain the subject heading for e-mail message transmissions.

EmailAttachField
The name of a field in activity tables that will contain the name of an attachment file, if any, to accompany an e-mail transmission.

EMailSubject
The default subject heading to use on e-mail transmissions, when no subject is specified via EMailSubjectField.

EmailMergeDelimiters
ASCII values of characters that preceed and follow a merge field in an e-mail form letter text file (e.g. 171,187 for MS Word form letters saved as Text Only with Line Breaks).

WordPerfectPath

Path in which WordPerfect for Windows program resides.

Contact Tab


CheckAreaCode
When a phone number is entered in the contact window, shall WinSales automatically lookup the state, if one is not already specified, and insert it into the State field?  0=no, 1=yes.

CheckState
When a state is entered in the contact window, shall WinSales verify it is a valid state per the State table?  0=no, 1=yes.

CheckAddressPhone
When an address or phone number is changed in the contact window, shall WinSales check to see if other contacts with the same company name have the same, original address and ask you if the change should also be applied to them?  0=no, 1=yes.

DetectDups
When a contact is added by the user, shall WinSales use the MatchCode algorithm to look for duplicate names already in the database?  0=no, 1=yes.

ContactDisplayPreference
In the Activity Log and other tabs in the Activity window, what shall WinSales display as the contact?  0=First/Last Name, 1=Company Name.

OrgChartAttribute

Field from contact window to include with name in organization chart.

ZipTabStop
When TAB is pressed in the Address field in the contact window, to which field shall WinSales next move?  0=City, 1=Zip Code.  

EMailAddressAttribute
The attribute in the Contact table that contains the contact's e-mail address.

OrgGroupAttribute
The attribute in the Contact table that is used to populate the Organization Chart.  Default is Company Name.  If something other than Company Name, the hierarchy/indentation feature of the organization chart is not available.

OrgChartMax
Maximum number of entries to display in an Organization Chart.  Zero indicates no maximum, although Windows itself has limitations as to the size of the chart.

AutoFindForActivity
If "1", any time an activity record is retrieved in the Activity window, the associated contact displays in the Contact window.  If zero, the Contact window remains unchanged.





SP recommends: 1

ShowActivityForOne
If "1", any time a contact record is retrieved in the Contact window, any activity records that are displayed on any tab of the Activity window (other than Activity Log) that are not associated with the contact are cleared from the screen.  If "0", the activity window tabs (other than Activity Log) remain unchanged.
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Sync Tab


SyncPath
Path to which sync files are written and from which sync files are read, during a synchronization import or extract.

SyncExtractDocs
When performing a sync extract, shall WinSales include word processing documents, referenced by sync'd activities, that have also changed since the date and time of last sync?  0=no, 1=yes.

SyncImportDocs
When performing a sync import, shall WinSales create and modify word processing documents that may have been transmitted as part of the sync?  0=no, 1=yes.  

IgnoreActivityRep
Used by Remote Synchronization process to determine which reps (sites) to send a change to (for Contact and Activity changes).  If set to 0, WinSales looks at any sales reps the contact is directly tied to (via magnifiers in the Contact window), as well as the sales reps on every activity tied to the contact.  If set to 1, WinSales does not look at all of the activities... only contact-to-sales rep links.  Setting to 1 can improve performance dramatically, for rep-specific remote synchronizations.

DaysToRetainDeletes
Used by Remote Synchronization process to determine the number of days the audit trail retains knowledge of deleted records.  This is only applicable when a user creates a sync extract file for a back-dated period, in which case deletes will be re-applied up to the number of days specified by this option.

Tuning Tab

SearchResultIncrement
Number of records to initially display when viewing query results in the workbench.  Also, the number of additional records to display when user DOUBLE CLICKs on More (CTRL+DOUBLE CLICK displays all remaining results).

MaxForegroundResults
Maximum number of records to retrieve when conducting a Find or when conducting a query from the workbench.

MaxBackgroundResults
Maximum number of records to retrieve when conducting workbench functions other than query.

DDEPause
Number of iterations of idle processing WinSales performs after each DDE transmission (except in Triggers).  If your word processor is not responding properly to WinSales' requests, try increasing this number.  If your word processor is pausing too long waiting for instructions from WinSales, try lowering this number.  Zero is lowest setting.

DDETimeOut
Number of milliseconds WinSales waits for acknowledgment of its DDE transmissions.  If Ami Pro mail merges are not operating properly, try increasing this value.

DatabaseIDAllocation
You will normally not modify this setting.  The number of IDs WinSales reserves from the ID pool each time it needs additional IDs.  Larger numbers yield better performance when doing mass inserts (but be sure to set back to 10 when your mass insert process is complete).

RepositoryIDAllocation
You will normally not modify this setting.

MaxTransTime
Maximum number of seconds WinSales allows a transaction to be pending until it is committed.  Higher numbers yield better performance for mass insert and mass update functions, but could lock larger portions of the database.  Lower numbers yield slower performance, but also minimizes the number of database pages that are locked.

MaxRetrieve
The number of activities retrieved when searching the Activity Log.

FilterCurrentSalesRep

Shall WinSales limit activity log searches to activities for the current sales rep only?  0=no, 1=yes.

FilterCurrentCampaign
Shall WinSales limit activity log searches to activities for the current campaign only?  0=no, 1=yes.  See 

FilterCurrentDay

Shall WinSales limit activity log searches to the current day only?  0=no, 1=yes.

FindOnContact
If zero, retrieving a contact in the Contact window has no impact on the contents of the Activity Log.  If "1", retrieving a contact in the Contact window causes the Activity Log to be populated with that contact's activities, so long as the activity window is visible and the activity log tab is the one chosen in that window.  If "2", retrieving a contact in the Contact window causes the Activity Log to be populated with that contact's activities, so long as the activity window is visible, but regardless of which tab in that window is chosen.
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ResetOnClear


When the actvity log is cleared, shall WinSales reset all the above Filter settings to 0?  0=no, 1=yes.

CorrespondenceAttribute
Indicates the field from the Correspondence window you would like to have displayed in the Reference column in the Activity Log.  Note that there is a setting for each type of activity (e.g., Inbound CallAttribute, MeetingAttribute, etc.).  

ShadowCnt
The number of points to the right and left of center to clear when erasing data from a WinSales screen.  Some video drivers leave faint shadows, or remnants of data when you clear a WinSales window.  If you experience this, set this option to 5.

ShadowInc
The inverval applied to shadow removal.  If you experience shadows, set this option to 5.  If the problem is not resolved after leaving and returning to WinSales, set this option to 1.

ActLogHide
A series of eight digits representing the eight columns that appear in the Activity Log.  If any position is set to a "1", the corresponding activity log column is hidden from view (you may still resize the column to make it appear if you need to).  The eight columns, in order from left to right, are: Type, Date, Time, Contact, Sales Rep, Campaign, Status, Reference.

ActLogAutoSize
If "1", columns in the activity log are automatically sized to accomodate the longest value encountered in the column.  If "0", columns are not auto-sized, and you must manually adjust the sizes using the mouse.

FindOnContact
If zero, retrieving a contact in the Contact window has no impact on the contents of the Activity Log.  If "1", retrieving a contact in the Contact window causes the Activity Log to be populated with that contact's activities, so long as the activity window is visible and the activity log tab is the one chosen in that window.  If "2", retrieving a contact in the Contact window causes the Activity Log to be populated with that contact's activities, so long as the activity window is visible, but regardless of which tab in that window is chosen.

LockDelay
The number of seconds that an idle session will wait before open tables are closed and reopened.  This procedures frees any file locks to prevent the idle session from hanging an active process.

MaxTransRecs
The maximum number of records that compose a single transaction. The default is 100.  For high volumes of processing (mass-assign, import, etc.) setting this value higher will improve performance of the workstation performing the processing, but decreases performance of other workstations.  

SQLMaxConnect
The maximum number of SQL Server connections a WinSales program established per session.  The number of connections WinSales utilizes depends on the type of functions being performed in WinSales.  Default is 10.  Heavy users of action plans, triggers and the activity log may lower this to 8; others may lower this to 6.

Calendar Tab


AlarmInterval
The WinSales Alarms program "wakes up" every time this number of minutes passes, to see if it should alert you as to an upcoming appointment.

AlarmNoLeadTime
For activities with no lead time.  If zero, you are not alerted to such scheduled activities.  If 1, you are alerted at the time at which the activity is scheduled to occur.

Style



The style of calendar printing you prefer.  0 - DayTimer format; 1 - Franklin Day Planner format.

Size
The size of calendar printing you prefer.  The best way to set this is to activate WinSales' calendar window, choose Print from the File menu, then choose the desired size.  WinSales remembers your last style and size settings the next time you print a calendar.

TaskLookAhead
In days, how far into the future WinSales looks when populating the Tasks tab in the calendar window.  Default is 365 days.

DrillPreference
If zero, double-clicking an appointment in the Calendar window causes the appointment scheduling summary window to appear.  If one, double-clicking an appointment in the Calendar window moves directly to the activity window detail for the appointment, bypassing the summary window.  User may CTRL+DoubleClick to drill in the manner opposite of this setting.

AlarmEnabled
Shall WinSales alert you to upcoming scheduled activities, scheduled for you using the WinSales calendar?  0=no, 1=yes.

WorkDays
When WinSales schedules activities via an Action Plan, which days of the week shall it be permitted to scheduled activities for?  1=Sunday, 7=Saturday.  For example, weekdays would be: 23456.

Dialer
Enabled

Shall WinSales take control of your modem for auto-dialing purposes?  0=no, 1=yes.

Port



The number of the COM port your modem is attached to for dialing purposes.

DialPrefix


Codes to send your modem prior to dialing the phone number.  Refer to your modem's manual.

HangupPrefix


Codes to send your modem just prior to it disconnecting from your call.  Refer to your modem's manual.

SetupPrefix
Codes to send your modem when WinSales first takes control of the modem.  Refer to your modem's manual.

LocalAreaCode
Your 3-digit area code.  Used by WinSales in helping decide if the call is long distance and should include a "1".

DialSuffix


Codes to send your modem after dialing the number.  Refer to your modem's manual.

HangupSuffix


Codes to send your modem after disconnecting from your call.  Refer to your modem's manual.

SetupSuffix


Codes to send your modem once WinSales has taken control of it.  Refer to your modem's manual.

CommPortMode
COM port designator, baud rate, parity setting, start and stop bit settings.  For example: COM1:1200,n,8,1.  Refer to your Windows 95 or DOS manual, and your modem's manual for details.

OffLineDelay


Number of seconds your modem remains connected to the call after dialing the number.
In the Incident Tracking category:

Note that this category only exists if you have set up incident tracking for an activity named Incident, using the appropriate wizard.  Note also, that a similar category will exist for each other activity you have established as an incident tracking summary type of activity.

NumberField
Name of the field in the incident activity and other activities that contains the unique incident tracking number.

TitleField


Name of the field in the incident activity that contains the unique title of the incident.

AccountField
Name of the Contact field used to identify an account.  For example, Company Name or Account Number.

In the Internet category:

Enabled
Indicates if WinSales' Internet features are enabled.  "0" indicates they are not.  "1" indicates they are.  This enables/disables the Search+Internet and Search+Goto+HomePage menu items.

Browser


Path and file name of your Internet browser program (e.g., Microsoft Internet Explorer or Netscape).

SearchEngine
Name of the Internet search engine to be used when Search+Internet menu item is chosen.  The value indicated here must correlate to the name of a search engine setting also found in this category.  For example, Yahoo.

HomePage


Internet address of your home page.

Yahoo
Internet address, including parameters used for searching, that prefaces the search criteria when conducting a search.  Note that there is a similar setting named for each major search engine.  You may create additional entries for other search engines.  The name of this setting may be specified as the value for the SearchEngine setting, noted above.

In the Crystal Reports category:

Note that this category only exists if you have attached the CrystalReportsInterface trigger to an export workbench process and executed it.

EXEPath


Path and file name of the Crystal Report Writer program.

RptPath


Path of the Crystal Reports report definition files.

Registered
Set this to "0" (zero) if you have not yet registered Crystal Reports (you'll know because you'll receive a registration window each time you start Crystal Reports).  Set this to "1" if you have registered Crystal Reports.

Other
Other settings in this category are actually named for each Export workbench process to which the CrystalReportsInterface trigger is attached.  The setting is the name of the Crystal Reports definition file that contains the report format information for the workbench process.  If no path is contained in the setting value, RptPath is assumed.  
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Determines the User's settings you are viewing or changing.









